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EM-PB-GATEWAY-IFS

Application note 

1 Description

The EM-PB-GATEWAY-IFS is a module which enables 

connection of the EMM...IFS modules and PSR-TRISAFE to 

the PROFIBUS-DP. The module is certified in accordance 

with the DPV 1 specification (EN 50170).

The EM-PB-GATEWAY-IFS can communicate via the 

TBUS with up to 32 EMM...IFS modules. 8 digital inputs and 

4 outputs can be freely parameterized.

The EM-PB-GATEWAY-IFS also supports Fail Safe: as the 

switching behavior can be influenced by the 

parameterization in the event of PROFIBUS errors. Digital 

switching outputs allow direct control of the EMM...IFS 

(forward/reverse running).

The GSD file (containing the communication characteristics 

of a PROFIBUS-DP device) can be found on the Internet at 

www.phoenixcontact.net/catalog.

Figure 1 PROFIBUS gateway for electronic motor 

management modules
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up to EMM ... IFS 31, EMM ... IFS 32

Control system (PLC)

(DPM1)

Diagnostics/maintenance

(DPM2)

Startup

(DPM2)

Make sure you always use the latest documentation. 

It can be downloaded at www.phoenixcontact.net/catalog.

Application note for the EM-PB-GATEWAY-IFS and 

STEP 7 software
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2 Downloading the GSD file

1. Access the Phoenix Contact Online Catalog 

(www.phoenixcontact.net/catalog) and search for 

"EM-PB-GATEWAY-IFS" or "2297620".

2. Select "Downloads".

Figure 2 Selecting downloads in the Online Catalog

3. Click on the GSD file "PXC_0B51.gsd".

Figure 3 Selecting a GSD file in the Online Catalog

4. Read the General Terms and Conditions of Use. 

5. Click "Accept" to confirm that you agree with the 

General Terms and Conditions of Use.

Figure 4 General Terms and Conditions of Use

6. Save the GSD file by clicking the "OK" button.

Figure 5 Saving the GSD file

3 Operating and indication elements 

of the EM-PB-GATEWAY-IFS

Figure 6 Operating and indication elements

1.Button for setting the PROFIBUS address

2.Status LEDs

4 Addressing example

Figure 7 Addressing example

The status LEDs are used for displaying the 

PROFIBUS address and addresses of the 

connected IFS devices in parameterization mode 

during the address setting process.

The PSR-TRISAFE-... module must be assigned 

the IFS address1.

CPU

IFS address: 2

PROFIBUS address: 2

PROFIBUS address: 4

IFS address: 1
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5 Setting the PROFIBUS address at 

the EM-PB-GATEWAY-IFS

1. Press button 1 (see Figure 6 on page 2) at the 

EM-PB-GATEWAY-IFS for 6 seconds.

2. The LEDs 2?at the EM-PB-GATEWAY-IFS display the 

current PROFIBUS address offset.

3. Set the PROFIBUS address offset by pressing the button 

1?at the EM-PB-GATEWAY-IFS (see table).

4. Press button 1 at the EM-PB-GATEWAY-IFS for 

6 seconds.

6 INTERFACE system addressing

1. Press button 1 at the EM-PB-GATEWAY-IFS for 

12 seconds.

2. The LEDs 2?at the EM-PB-GATEWAY-IFS display the 

current IFS address of the first device on the IFS-Bus.

3. Set the IFS address by pressing the button 1 at the 

EM-PB-GATEWAY-IFS (see table).

4. Press the button on the first device e.g.

EMM…IFS = Reset button 

TRISAFE = Confirmation button

5. The IFS address is applied at the first device.

6. At the EM-PB-GATEWAY-IFS, the address of the next 

device is displayed. Repeat steps 3 and 4 until all 

devices have been addressed.

7. Press button 1 at the EM-PB-GATEWAY-IFS for 

12 seconds.

8. All status LEDs light up briefly.

The EM-PB-GATEWAY-IFS calculates the 

PROFIBUS address by adding the offset to the 

base address.

The base address is set to 0 by default and can be 

modified by means of (DTM) or IFS-CONFSTICK 

software.

LED code
Offset

PWR DAT ERR BF SF

0 0 0 0 0 0

0 0 0 0 1 1

0 0 0 1 0 2

0 0 0 1 1 3

0 0 1 0 0 4 Default offset

0 0 1 0 1 5

0 0 1 1 0 6

0 0 1 1 1 7

0 1 0 0 0 8

0 1 0 0 1 9

0 1 0 1 0 10

0 1 0 1 1 11

0 1 1 0 0 12

0 1 1 0 1 13

0 1 1 1 0 14

0 1 1 1 1 15

1 0 0 0 0 16

1 0 0 0 1 17

1 0 0 1 0 18

1 0 0 1 1 19

1 0 1 0 0 20

1 0 1 0 1 21

1 0 1 1 0 22

1 0 1 1 1 23

1 1 0 0 0 24

1 1 0 0 1 25

1 1 0 1 0 26

1 1 0 1 1 27

1 1 1 0 0 28

1 1 1 0 1 29

1 1 1 1 0 30

1 1 1 1 1 31

LED code IFSM 

addressPWR DAT ERR BF SF

0 0 0 0 0 0

0 0 0 0 1 1

0 0 0 1 0 2

0 0 0 1 1 3

0 0 1 0 0 4

0 0 1 0 1 5

0 0 1 1 0 6

0 0 1 1 1 7

0 1 0 0 0 8

0 1 0 0 1 9

0 1 0 1 0 10

0 1 0 1 1 11

0 1 1 0 0 12

0 1 1 0 1 13

0 1 1 1 0 14

0 1 1 1 1 15

1 0 0 0 0 16

1 0 0 0 1 17

1 0 0 1 0 18

1 0 0 1 1 19

1 0 1 0 0 20

1 0 1 0 1 21

1 0 1 1 0 22

1 0 1 1 1 23

1 1 0 0 0 24

1 1 0 0 1 25

1 1 0 1 0 26

1 1 0 1 1 27

1 1 1 0 0 28

1 1 1 0 1 29

1 1 1 1 0 30

1 1 1 1 1 31
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7 Integration in STEP 7

1. Start SIMATIC Manager

Figure 8 SIMATIC Manager icon

2. Create a new project

Figure 9 Creating a new project

3. Assign project name and click "OK"

Figure 10 Saving project name

4. Under the menu command "Insert" > "Stations", select 

the appropriate CPU.

Figure 11 Selecting the CPU

5. The selected CPU is inserted into your project.

Figure 12 Selected CPU

6. Open the context menu of the inserted CPU. 

Click on "Open object".

Figure 13 Opening the object
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7. The hardware configuration is displayed.

Figure 14 Hardware configuration

8. Close all application windows.

Figure 15 Hardware configuration

9. Open the "Options" menu and select the "Install New 

GSD..." command.

Figure 16 Installing a GSD file

10. Now load the GSD file downloaded in chapter 2.

11. If the "Installation has been completed successfully" 

message appears, you can close the hardware editor.

Figure 17 "Installation has been completed successfully" 

message

12. Open the context menu of the inserted CPU.

Click on "Open object".

Figure 18 Opening the object
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13. Open the "View" menu and then select "Catalog".

Figure 19 Selecting the catalog

14. The catalog window appears.

Figure 20 Catalog window

15. Suitable devices must now be inserted into your project 

here.

7.1 Example with SIMATIC 300

1. Select "SIMATIC 300" → "RACK 300" → "Rail" and 

insert this into your project.

Figure 21 Selecting the DIN rail

2. Select "SIMATIC 300" → "CPU 315-2 DP" 

→ "6ES7-315-2AF03-0AB0" → "V1.2" and insert this 

into your project.

Figure 22 Selecting the CPU
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3. The "Properties" window appears. 

Click "New" and enter a new name for the bus line.

Figure 23 Bus line name

4. Select "PROFIBUS-DP" → "Additional Field Devices" 

→ "Gateway". 

Now move the EM-PB-GATEWAY-IFS into your project.

Figure 24 Selecting the gateway

5. The "Properties" window appears. 

Under "Address", you must select the address which 

was configured in the EM-PB-GATEWAY-IFS in 

chapter 4.

Figure 25 Gateway properties

6. You can now move the required GSD data into your 

project from the Catalog window under the 

"EM-PB-GATEWAY-IFS" item.

Figure 26 GSD data
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8 Setting: byte order

1. Open the context menu of the EM-PB-GATEWAY-IFS 

and select "Object properties".

2. Activate the "Parameter Assignment" tab.

Figure 27 Setting the byte order

3. The byte order of the transferred data can be set here 

under "Device-specific parameters" by selecting 

"Byte order".

8.1 Example: "EMM: COS ϕ" value

Figure 28 Example: "EMM: COS ϕ" value

9 Explanation of GSD data

The package slip can also be downloaded from the 

Phoenix Contact Online Catalog.

1. Access the Phoenix Contact Online Catalog 

(www.phoenixcontact.net/catalog) and search for 

"EM-PB-GATEWAY-IFS" or "2297620".

2. Select "Downloads".

Figure 29 Selecting downloads in the Online Catalog

3. Click on the "packb_em_...pdf" package slip.

Figure 30 Selecting package slips in the Online Catalog

4. Save the pdf file or open if you wish to view the file.

9.1 GSD data for EM-PB-GATEWAY-IFS

Motorola: Big Endian (the most significant byte is saved 

first of all)

Intel: Little Endian (the least significant byte is saved 

first of all)

Cos ϕ = 0.3661

A detailed description can be found on the 

package slip of the EM-PB-GATEWAY-IFS, 

which is provided with the product.

Universal module

Digital inputs, outputs

Gateway: Module state

Gateway: Channel State 1

Gateway: Channel State 2

Gateway: Channel State 3

Gateway: Channel State 4

IFS: Slave Error State 1

IFS: Slave Error State 2

IFS: I/O State 1

IFS: I/O State 2

DOWNLOADED FROM WWW.SCATTS.CO.UK

DOWNLOADED FROM WWW.SCATTS.CO.UK



EM-PB-GATEWAY-IFS

104303_en_01 PHOENIX CONTACT 9

9.2 GSD data for EMM … IFS 9.3 GSD data for PSR-TRISAFE-S

9.4 GSD data for PSR-TRISAFE-M

ELR, EMM Objects ============

EMM: Control (Device:1) 1 = IFS address 1

EMM: Control (Device:2) 2 = IFS address 2

EMM: Control (Device:3) 3 = IFS address 3

EMM: Control (Device:4) 4 = IFS address 4

EMM: Control (Device:5) 5 = IFS address 5

EMM: Control (Device:6) 6 = IFS address 6

EMM: Control (Device:7) 7 = IFS address 7

EMM: Control (Device:8) 8 = IFS address 8

EMM: Status

EMM: Module State 1 

EMM: Module State 2

EMM: Channel State 1

EMM: Channel State 2

EMM: Channel State 3

EMM: Channel State 4

EMM: P(ALL)

EMM: U(L1)

EMM: U(L2)

EMM: U(L3)

EMM: I(L1)

EMM: I(L2)

EMM: I(L3)

EMM: Electric Work

EMM: COS PHI

EMM: Frequency

EMM: Operation time (left)

EMM: Operation time (right)

EMM: Cycle (left)

EMM: Cycle (right)

EMM: P(L1)

EMM: P(L2)

EMM: Q(ALL)

EMM: S(ALL)

EMM: SQRT(3) * U(L1)

EMM: SQRT(3) * U(L2)

EMM: SQRT(3) * U(L3)

If a PSR-TRISAFE is used, the IFS address 1 

must not be assigned to an EMM.

TriSafe Objects ==============

PSR-TS-S : Device 1 1 = IFS address 1

PSR-TS-S : Input 15 … 0
Safe inputs: 

I0 ... I15

PSR-TS-S : Input 19 … 16
Safe inputs: 

I16 ... I19

PSR-TS-S : SafeOut 3 … 0
Safe outputs: 

O0 ... O3

PSR-TS-S : UnSafeOut 15 … 0
Monitoring 

outputs: M0 ... M3

TriSafe Objects ==============

PSR-TS-M : Device 1 1 = IFS address 1

PSR-TS-M : Safe IN w01
Safe inputs: 

I0 ... I15

PSR-TS-M : Safe IN w02
Safe inputs: 

I16 ... I19

PSR-TS-M : Safe OUT w01
Safe outputs: 

O0 ... O3

PSR-TS-M : Diag IN w03

Diagnostic LEDs: 

PWR, DATA, 

ERR, CONF

PSR-TS-M : None Safe OUT w01

Monitoring 

outputs: M0 ... M3 

and external 

signals: 

EQ00 ,... EQ11

PSR-TS-M : None Safe OUT w02
External signals: 

EQ12 ... EQ27

PSR-TS-M : None Safe OUT w03
External signals: 

EQ28 ... EQ43

PSR-TS-M : None Safe OUT w04
External signals: 

EQ44 ... EQ59

PSR-TS-M : None Safe OUT w05
External signals: 

EQ60 ... EQ63

The "EMM: Control (Device: X)" control word is 

used simultaneously for assigning the values 

listed below to a suitable IFS address of the EMM 

to be addressed.

• Should you wish to integrate values from the 

EMM with the IFS address 1, the 

"EMM: Control (Device:1)" word must be 

inserted into the structure first of all.

All the words inserted there now relate to the 

EMM 1, until another control word is inserted with 

a different address.
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10 Example

The following modules are used in this example:

– SIMATIC S7-300

– EM-PB-GATEWAY-IFS

– EMM 3-24DC/500AC-16-IFS

– PSR-SCP-24DC/TS/S

10.1 Hardware structure

Figure 31 Hardware structure

10.2 Applied GSD values

CPU

IFS address: 2

PROFIBUS address: 2

PROFIBUS address: 4

IFS address: 1

Inputs and outputs of the EM-PB-GATEWAY-IFS

Control word of the EMM, e. g. forward running, reverse running, stop, 

Status word of the EMM, e. g. input state, direction of motor

Display: real power total

Display: frequency

Display: operating hours counter (reverse running)

Display: operating hours counter (forward running)

Display: cycles (reverse running)

Display: cycles (forward running)

Display: voltage L1

Display: voltage L2

Display: voltage L3

Display: current L1

Display: current L2

Display: current L3

Must be set (PSR-TRISAFE-S is assigned IFS address 1)

Display: safe inputs I0 ... I15

Display: safe inputs I16 ... I19

Display: safe outputs O0 ... O3

Display: monitoring outputs M0 ... M3
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10.3 Monitoring variables

Figure 32 Opening the context menu of the 

EM-PB-GATEWAY-IFS 

Figure 33 Object properties of the EM-PB-GATEWAY-IFS

• In the object properties of the EM-PB-GATEWAY-IFS, 

the conversion factors for the measured values can be 

specified.

Figure 34 Variable overview 

• In the variable overview, individual values can now be 

displayed.

In the example image, you can see, for  example, that the 

real power (All) amounts to 278 W.

For each EM-PB-GATEWAY-IFS, a maximum of 

32 words can be transferred in the cycle (66 ms).
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